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Cel ćwiczenia

W ramach ćwiczenia: 

• Zapoznasz się z modelowaniem liniowosprężystego układu tarczowego z 

wykorzystaniem dwuwymiarowych elementów skończonych.

• Dokonasz sprawdzenia poprawności wyników przez porównanie ze znanymi 

rozwiązaniami wartości współczynnika kształtu.

• Do wykonania zadania wykorzystasz programy Hypermesh i OptiStruct, które

możesz pobrać ze strony internetowej: https://altairone.com/Marketplace

• Pamiętaj, żeby najpierw zarejestrować się, pobrać i zainstalować obydwa 

programy!

• Instrukcja jest przygotowana dla wersji 2025.1
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https://altairone.com/Marketplace


Parametry układu
• Modelowana będzie próbka płaska z dwustronnym symetrycznym 

odsadzeniem. Wymiary na dolnym rysunku podane są w milimetrach.

• Materiał: stal

• Siła obciążająca: P=100 N

• Ze względu na symetrię układu modelowana będzie połówka leżąca po 

jednej stronie osi symetrii. Symetria będzie uwzględniona przez zadanie 

odpowiedniego podparcia układu oraz odpowiedniej wartości siły (jakiej?).
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Dietrich M. (red.): Podstawy 
konstrukcji maszyn, tom 1, 
WNT, Warszawa 1999.



• Wartość współczynnika kształtu Kt (co to jest?) możesz odczytać z interaktywnego wykresu.

• Zaloguj się do bazy Knovel przez stronę Biblioteki Politechniki Śląskiej i wyszukaj podaną książkę a w niej interaktywny 

wykres Chart 3.1.

• https://www.polsl.pl/bps/knovel/
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Rozwiązanie do porównania

https://www.polsl.pl/bps/knovel/
https://www.polsl.pl/bps/knovel/
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Uruchom program

Uruchom program Hypermesh

1. Wybierz rodzaj sesji – Hypermesh.

2. Wybierz profil (program wykonujący właściwe obliczenia): 

OptiStruct.

3. Wybierz katalog roboczy (możesz utworzyć własny 

podkatalog).

4. Utwórz sesję.
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Zapisz projekt

Uruchom program Hypermesh.

1. Wybierz File -> Save As…

2. Wybierz HyperMesh Model.

3. Wpisz nazwę pliku i kliknij Zapisz.
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Dobrym nawykiem jest 
zapisywanie projektu po 
wykonaniu każdego etapu. 
Najłatwiej jest to robić 
kombinacją klawiszy 
CTRL+S



Ustaw jednostki

1. Wybierz File -> Preferences.

2. Ustaw układ jednostek.
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Utwórz szkic

1. Wybierz pasek Sketch, New Sketch.

2. Wybierz płaszczyznę XY, Create.

3. Uruchomił się tryb szkicu.
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Utwórz szkic

1. Wybierz Rectangles. Narysuj prostokąt.

2. Wybierz Dimensions. Wskaż poziomy bok prostokąta, 
wpisz wymiar, zatwierdź klawiszem Enter.

3. Narzuć wymiar pionowy oraz dorysuj drugi prostokąt. 
Wprowadź pozostałe wymiary.
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Utwórz szkic, cd.

1. Wybierz Trim.

2. Kliknij 2xLPM (lewym przyciskiem myszy) 
wspólną krawędź prostokątów do usunięcia.

3. Wybierz Fillet.

4. Wskaż wierzchołek i wprowadź długość 
promienia zaokrąglenia. Potwierdź wybór.
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Utwórz szkic, cd.

1. Wybierz Offset.

2. Wskaż obrys figury i wprowadź odległość: 2.0 mm Potwierdź 
operację.

3. Wskaż linię i usuń ją klawiszem Delete.

4. Usuń podobnie pozostałe niepotrzebne linie.

5. Wyjdź z trybu szkicowania dwukrotnie naciskając Escape.
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Utwórz materiał
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1. Wybierz pasek Model, narzędzie Materials.

2. Wprowadź nazwę oraz własności (E – moduł Younga, G – 
moduł Kirchhoffa, NU – liczba Poissona, RHO - gęstość). 

3. Kliknij Close. Zwróć uwagę na nowy obiekt w drzewie 
modelu.

W przypadku stali program sam podpowiada 
odpowiednie wartości. Wielkości G oraz RHO 
nie są podane w treści naszego zadania, lecz 
program wymaga ich wprowadzenia 
(szczególnie gęstość nie jest wykorzystywana 
w analizie statycznej a moduł Kirchhoffa może 
być obliczony dla materiału izotropowego na 
podstawie E i NU).



Utwórz własności elementów
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1. Wybierz pasek Model, Properties

2. Wprowadź własności elementów skończonych – typ 
PSHELL, materiał stal. Symbol T oznacza grubość.

3. Kliknij Close. 

Wybrany element PSHELL to powłoka, która jest szerszym sformułowaniem 
niż elementy w płaskim stanie naprężenia lub odkształcenia (dodatkowo 
uwzględnia zginanie i odkształcenie poprzeczne). Wybrane ustawienia 
ograniczają wybrane sformułowanie tylko do płaskiego stanu naprężenia 
(ang. plane stress). Dokumentacja: PSHELL

https://2021.help.altair.com/2021.2/hwsolvers/os/topics/solvers/os/pshell_bulk_r.htm?zoom_highlight=PSHELL


Przypisz własności do komponentu
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1. W panelu bocznym wybierz zakładkę Model. Kliknij 
2xLPM na obiekt Components (1).

2. W zakładce Components wybierz Sketch.1 i rozwiń 
Property.

3. Wybierz własności tarczowy.
4. Potwierdź wybór.
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Dopasuj lokalnie rozmiar siatki
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1. W pasku 2D wybierz Freeform.

2. Rozwiń menu ustawień siatki – automatyczny dobór elementów 
czworokątnych lub trójkątnych o kwadratowych funkcjach 
kształtu i rozmiarze 1 mm. Schowaj menu tym samym 
przyciskiem.

3. Wybierz wszystkie powierzchnie Ctrl+A, Mesh.

4. Wybierz kolejno liczbę elementów na promieniach i ustaw na 5 
(Ctrl+Rolka). Po każdej zmianie potwierdź Update
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Popraw położenie węzłów

16

2

1

1. W zakładce 2D wybierz Edit Elements.

2. Wybierz Move. Możesz w ten sposób w 
razie potrzeby manualnie poprawić 
kształt elementów.



Sprawdź jakość elementów
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1. W zakładce 2D wybierz Auto Quality.

2. Wybierz 2D oraz QI Range. Obniż suwak przy kolorowym pasku. Tylko jeden 
element jest stosunkowo niskiej jakości – kąty odbiegają znacząco od kąta 
prostego. Element ten leży poza zakresem spiętrzenia naprężeń (promienia) i nie 
wpłynie na wynik naprężeń w tym miejscu. Siatka może być zaakceptowana.

Jakość elementu zależy od jego kształtu, w tym od 
kątów pomiędzy jego bokami. W programie 
Hypermesh obliczany jest wskaźnik Quality Index 
(QI) zależny od wartości dwunastu rożnych 
kryteriów pogrupowanych na pięciu poziomach.
Review 2D Elements by Quality Index

https://2021.help.altair.com/2021.2/hwdesktop/hwx/topics/pre_processing/meshing/2d_element_quality_by_quality_index_review_t.htm?zoom_highlight=quality+index


1. W pasku Model wybierz Sets.

2. Ustaw: Name: lewy, Card Image: SET_GRID.

3. Kliknij        przy Nodes. Wybierz By Line i kliknij 
lewy pionowy bok tarczy. Potwierdź Apply.

4. Potwierdź zielonym haczykiem i Close.

5. W podobny sposób utwórz zbiory zawierające 
węzły na dolnym poziomym boku (dolny) i prawym 
pionowym (prawy; składa się on z dwóch 
odcinków).
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Zdefiniuj grupy węzłów
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1. W panelu Model wybierz SET_GRID (3). Otworzy się panel 
Sets

2. Wybierz lewy i naciśnij klawisz Q (review). Podświetlą się 
odpowiednie węzły modelu.

3. Podobnie sprawdź zbiór dolny.

4. Podobnie sprawdź zbiór prawy.

W razie potrzeby popraw model!
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Sprawdź utworzone grupy
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1. Kliknij pasek Analyze, Constraints.

2. Ustaw SPC, wybierz Sets oraz Sets Advanced Selection.

3. Z listy zbiorów wybierz lewy, Apply, potwierdź haczykiem.

4. Wyzeruj przemieszczenia liniowe wzdłuż osi X (DOF1) 

oraz Z (DOF3). Wybierz Create, Close.

5.     W strukturze projektu znajdź SPC (1) i naciśnij Q (Review). 
Sprawdź na modelu zadane podparcie.
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Zdefiniuj pierwszą część podparcia
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W podobny sposób jak poprzednio zdefiniuj podparcie w węzłach zbioru dolny. Tym 
razem odbierz możliwość przesunięcia wzdłuż osi Y (DOF2) oraz Z (DOF3).

Zdefiniuj drugą część podparcia
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Zdefiniuj węzeł przyłożenia siły
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1. Wybierz pasek Topology, narzędzie Points/Nodes
2. Wskaż orientacyjnie położenie węzła. Dokładne 

współrzędne możesz wpisać w okienku. Zatwierdź je 
klawiszem Enter.

3. Wybierz Create Free Nodes.
4. Utworzony został węzeł, w którym zadana zostanie siła 

obciążająca pionową krawędź.
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Zdefiniuj obciążenie, cd.
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1. Wybierz pasek Model, narzędzie Rigids.

2. Odznacz Auto Create. W polu Independent Nodes wybierz nowy 
węzeł, zatwierdź wybór zielonym haczykiem,

3. W polu Dependent Nodes zaznacz węzły na prawym boku – zbiór 
prawy, Apply. Zatwierdź wybór zielonym haczykiem. Zwiąż 
elementem sztywnym wszystkie przemieszczenia poza pionowym 
(nie wpisuj 2). Potwierdź Create, Close.

4. Sprawdź nowy obiekt w drzewie.
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Zdefiniuj obciążenie, cd.
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1. Wybierz pasek Analyze, narzędzie Constraints.

2. W polu Entities wybierz węzeł, w którym będzie zadana siła. 
Wymuś brak obrotów DOF4-6: 0. Potwierdź Create.

3. W drzewie projektu rozwiń PPM obiekt Loads a następnie 
ostatni z obiektów. Naciśnij Q (Review). Sprawdź, czy zadane 
są prawidłowe przemieszczenia.
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1. Wybierz pasek Model, kliknij 2xPPM (prawym przyciskiem myszy) 
obiekt Collectors.

2. W zakładce Load Collectors wybierz Create Load Collectors. Nowy 
obiekt nazwij sila. Będzie on zawierał definicję obciążenia.

3. Upewnij się, że nowy obiekt jest aktywny. Jego nazwa musi być 
pogrubiona. W razie potrzeby wybierz PPM, Make Current.

3

Zdefiniuj obciążenie, cd.
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Zdefiniuj obciążenie, cd.
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1. Wybierz pasek Analyze, narzędzie Forces.

2. W polu Entities wskaż utworzony pojedynczy węzeł. 
Zatwierdź zielonym haczykiem.

3. Wpisz dane wektora siły – wartość Magnitude: -50, 
kierunek osi X (Direction: 1, 0, 0). Kliknij Create, Close.

4. Sprawdź nowy obiekt w drzewie.
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Zdefiniuj przypadek obciążenia
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1. Wybierz pasek Analyze, narzędzie Analyze.
2. W panelu bocznym, w zakładce Loadsteps 

kliknij PPM na obiekcie Loadsteps -> New 
loadstep.

3. Wpisz nazwę sym1.
4. Wybierz typ: Linear static, potwierdź OK.
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Wprowadź parametry symulacji
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11. Wybierz panel Model, kliknij 2xLPM na SUBCASE.

2. We właściwościach obiektu sym1 ustaw collectory – SPC: auto1 
(przemieszczenia), LOAD: sila (obciążenie).

3. Przewiń w dół aż do OUTPUT – zaznacz.

4. Przewiń w dół aż do STRESS – zaznacz, wpisz liczbę przypadków: 1, format 
H3D (plik Hypermesha z wynikami naprężeń) oraz lokalizację wyniku 
naprężeń w elemencie – interpolacja do naroży: CORNER. 

Uwaga: Bez zaznaczenia ostatniej opcji uzyskasz na brzegu układu 
zaniżone wyniki naprężeń, wzięte z punktu środkowego elementu 
skończonego!
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Uruchom analizę
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1. Wybierz pasek Analyze, narzędzie Analyze.

2. Wpisz nazwę pliku z modelem, Zapisz.

3. W oknie eksportowania modelu wybierz All, Export.

4. W oknie Altair Compute Console wybierz Run.

5. W oknie Altair Compute Solver View powinien wyświetlić 
się komunikat ANALYSIS COMPLETED. 

Jeśli widać komunikaty o błędach – musisz dokładnie 
sprawdzić swój model…
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Wczytaj wyniki
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1. Wybierz View, Results file tarcza.h3d.

2. Poczekaj na uruchomienie programu 
HyperView.



1Wyświetl wyniki naprężeń
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1. Wybierz pasek Results, narzędzie Contour.

2. Ustaw odpowiedni rzut.

3. W dolnym panelu wybierz parametry mapy naprężeń: największe naprężenia główne dla 
układu płaskiego In-Plane P1 (major), wartości z naroży elementów Use Corner Data, 
sposób uśredniania wyników naprężeń w węzłach Simple, potwierdź Apply.

2

3



Sprawdź kształt obciążonego układu
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1. Wybierz pasek Results, narzędzie Deformation.

2. W panelu dolnym wpisz skalę przemieszczeń 1e4 lub 
10000, wybierz styl wyświetlania wyjściowego 
kształtu układu Wireframe, potwierdź Apply.

Czy układ odkształcił się zgodnie z oczekiwaniami?

Dlaczego odpowiednie krawędzie tarczy pozostały 
prostoliniowe, w szczególności ta obciążona siłą?
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Sprawdź wyniki naprężeń
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1. Wróć do Contour, w panelu dolnym wybierz Query Results.

2. Wskaż dwa węzły: z maksymalną wartością naprężeń w 
obszarze zaokrąglenia oraz prawe dolne naroże.

3. Odczytaj wartości naprężeń w tych punktach z tabelki na 
dole ekranu i oblicz wartość współczynnika kształtu. 
Możesz skorzystać z konsoli Pythona View -> Python 
Window.

Czy obliczona wartość ok. 2.05 zgadza się z danymi 
literaturowymi? Czy można ją uzyskać dokładniej? W jaki 
sposób?

Z czego wynika wartość naprężeń w obszarze prawej krawędzi 
tarczy? Czy Jesteś w stanie sprawdzić ją analitycznie na 
podstawie danych?
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Podsumowanie

Wykonując ćwiczenie nauczyłeś/aś się jak:

• Wykonać analizę układu płaskiego z wykorzystaniem elementów 
2D.

• Definiować zbiory wyników.

• Sprawdzić poprawność wyników analizy.
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KONIEC
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